ASCENT - Center for Technical Knowledge®
AutoCAD® 2018
3D Drawing & Modeling
Mixed Units - 1st Edition

Prepared and produced by:
ASCENT Center for Technical Knowledge
630 Peter Jefferson Parkway, Suite 175
Charlottesville, VA 22911
866-527-2368
www.ASCENTed.com

Lead Contributor: Michelle Rasmussen

ASCENT - Center for Technical Knowledge is a division of Rand Worldwide, Inc., providing custom developed knowledge products and services for leading engineering software applications. ASCENT is focused on specializing in the creation of education programs that incorporate the best of classroom learning and technology-based training offerings.

We welcome any comments you may have regarding this student guide, or any of our products. To contact us please email: feedback@ASCENTed.com.

© ASCENT - Center for Technical Knowledge, 2017

All rights reserved. No part of this guide may be reproduced in any form by any photographic, electronic, mechanical or other means or used in any information storage and retrieval system without the written permission of ASCENT, a division of Rand Worldwide, Inc.

The following are registered trademarks or trademarks of Autodesk, Inc., and/or its subsidiaries and/or affiliates in the USA and other countries: 123D, 3ds Max, Alias, ATC, AutoCAD LT, AutoCAD, the Autodesk logo, Autodesk 123D, Autodesk Homestyler, Autodesk Inventor, Autodesk MapGuide, Autodesk Streamline, AutoLISP, AutoSketch, AutoSnap, AutoTrack, Backburner, Backdraft, Beast, BIM 360, Burn, Buzzsaw, CADmep, CAICE, CAMduct, Civil 3D, Combustion, Communication Specification, Configurator 360, Constructware, Content Explorer, Creative Bridge, Dancing Baby (image), DesignCenter, DesignKids, DesignStudio, Discreet, DWF, DWG, DWG (design/logo), DWG Extreme, DWG TrueConvert, DWG TrueView, DWGX, DXF, Ecotec, Ember, ESTmep, FABmep, Face Robot, FBX, Fempro, Fire, Flame, Flare, Flint, ForceEffect, Format 360, Freewheel, Fusion 360, Glue, Green Building Studio, Heidi, Homestyler, HumanIK, i-drop, ImageModeler, Incinerator, Inferno, InfraWorks, Instructables, Instructables (styled robot design/logo), Inventor, Inventor HSM, Inventor LT, Lustre, Maya, Maya LT, MIMI, Mockup 360, Moldflow Plastics Advisers, Moldflow Plastics Insight, Moldflow, Moondust, MotionBuilder, Movimento, MPA (design/logo), MPA, MPI (design/logo), MPX (design/logo), MPX, Mudbox, Navisworks, ObjectARX, ObjectDBX, Opticore, P9, Pier 9, Pixlr, Pixlr-o-matic, Productstream, Publisher 360, RasterDWG, RealDWG, ReCap, ReCap 360, Remote, Revit LT, Revit, RiverCAD, Robot, Scaleform, Showcase, Showcase 360, SketchBook, Smoke, Socialcam, Softimage, Spark & Design, Spark Logo, Sparks, SteeringWheels, Stitcher, Stone, StormNET, TinkerBox, Tinkercad, Tinkerplay, ToolClip, Topobase, Toxik, TrustedDWG, T-Splines; ViewCube, Visual LISP, Visual, VRED, Wire, Wiretap, WiretapCentral, XSI.

NASTRAN is a registered trademark of the National Aeronautics Space Administration.

All other brand names, product names, or trademarks belong to their respective holders.

General Disclaimer:
Notwithstanding any language to the contrary, nothing contained herein constitutes nor is intended to constitute an offer, inducement, promise, or contract of any kind. The data contained herein is for informational purposes only and is not represented to be error free. ASCENT, its agents and employees, expressly disclaim any liability for any damages, losses or other expenses arising in connection with the use of its materials or in connection with any failure of performance, error, omission even if ASCENT, or its representatives, are advised of the possibility of such damages, losses or other expenses. No consequential damages can be sought against ASCENT or Rand Worldwide, Inc. for the use of these materials by any third parties or for any direct or indirect result of that use.

The information contained herein is intended to be of general interest to you and is provided "as is", and it does not address the circumstances of any particular individual or entity. Nothing herein constitutes professional advice, nor does it constitute a comprehensive or complete statement of the issues discussed thereto. ASCENT does not warrant that the document or information will be error free or will meet any particular criteria of performance or quality. In particular (but without limitation) information may be rendered inaccurate by changes made to the subject of the materials (i.e. applicable software), Rand Worldwide, Inc. specifically disclaims any warranty, either expressed or implied, including the warranty of fitness for a particular purpose.
Contents

Preface ............................................................................................................ ix
In this Guide ................................................................................................... xi
Practice Files ................................................................................................. xv

Chapter 1: 3D Foundations.......................................................................... 1-1
  1.1 Why Use 3D? ................................................................................... 1-2
      Types of 3D Models ................................................................. 1-2
  1.2 Introduction to the 3D Modeling Workspace ................................ 1-4
      3D Ribbon Panels ................................................................. 1-4
  1.3 Basic 3D Viewing Tools................................................................... 1-7
      Preset 3D Views ................................................................. 1-7
      Orbiting in 3D ........................................................................ 1-7
      Using Visual Styles .......................................................... 1-9
  1.4 3D Navigation Tools ...................................................................... 1-10
      ViewCube ............................................................................... 1-10
      SteeringWheel ..................................................................... 1-13
  Practice 1a 3D Navigation Tools ......................................................... 1-16
  1.5 Introduction to the User Coordinate System (UCS) ................... 1-19
      Dynamic UCS ....................................................................... 1-20
  Practice 1b Introduction to the User Coordinate System .......... 1-22
  Chapter Review Questions ...................................................................... 1-24
  Command Summary ............................................................................... 1-25

Chapter 2: Simple Solids .......................................................................... 2-1
  2.1 Working with Solid Primitives ...................................................... 2-2
      Drawing Solid Primitives .................................................... 2-2
      Editing Solid Primitives .................................................... 2-3
2.2 Solid Primitive Types ................................................................. 2-5
   Creating Boxes and Wedges ...................................................... 2-5
   Creating Pyramids ................................................................. 2-7
   Creating Cylinders and Cones ............................................... 2-9
   Creating Spheres and Tori ..................................................... 2-11
   Creating Wall-like Solids with Polysolid .................................. 2-13

Practice 2a Working with Solid Primitives - Architectural .......... 2-15
Practice 2b Working with Solid Primitives - Mechanical .......... 2-16

2.3 Working with Composite Solids .............................................. 2-18
   Creating Composite Solids .................................................. 2-18
   Modifying Composite Solids ................................................ 2-21

Practice 2c Working with Composite Solids ................................ 2-23
Practice 2d Mechanical Project - Machine Part ....................... 2-24
Practice 2e Architectural Project - Facade Puzzle ..................... 2-26

2.4 Working with Mesh Models ..................................................... 2-28
   Creating Mesh Primitives .................................................... 2-28
   Creating Mesh Models from Objects .................................... 2-30
   Editing Mesh Models .......................................................... 2-30
   Convert From Mesh Models ................................................. 2-35

Practice 2f Mesh Model .............................................................. 2-36

Chapter Review Questions ......................................................... 2-40
Command Summary ............................................................... 2-42

Chapter 3: Working with the User Coordinate System ............... 3-1

3.1 UCS Basics ............................................................................. 3-2
   UCS Icon .............................................................................. 3-3
   Moving the UCS Origin ........................................................ 3-5
   Moving the UCS to a Face .................................................... 3-6
   Moving the UCS Using 3 Points ............................................ 3-6

Practice 3a Using the UCS ......................................................... 3-8

3.2 UCS X, Y, and Z Commands .................................................. 3-11
Practice 3b X, Y, and Z Commands ............................................ 3-13

3.3 UCS Multi-functional Grips ................................................... 3-16

3.4 Saving a UCS by Name .......................................................... 3-17

Practice 3c Working with Named UCSs .................................... 3-20

Chapter Review Questions ......................................................... 3-21
Command Summary ............................................................... 3-22
## Chapter 4: Creating Solids & Surfaces from 2D Objects

### 4.1 Complex 3D Geometry
- Creating Surfaces and Solids

### 4.2 Extruded Solids and Surfaces
- Presspull
- Modifying Extrusions

**Practice 4a Creating an Extruded Solid**

**Practice 4b Extruding Along a Path**

### 4.3 Swept Solids and Surfaces
- Modifying Sweeps
- 3D Paths

**Practice 4c Creating a Swept Solid**

**Practice 4d Sweeping Along a Helix**

**Practice 4e Sweeping Along a 3D Polyline**

### 4.4 Revolved Solids and Surfaces
- Modifying Revolves

**Practice 4f Creating Revolved Solids**

### 4.5 Lofted Solids and Surfaces
- Modifying Lofts

**Practice 4g Creating a Lofted Solid**

**Practice 4h Basic Solid and Surface Editing**

### 4.6 NURBS Surfaces
- Creating NURBS Surfaces
- Edit NURBS Surfaces

**Practice 4i Create and Edit a NURBS Surface**

## Chapter Review Questions

## Command Summary

## Chapter 5: Modifying in 3D Space

### 5.1 3D Gizmo Tools

**Practice 5a 3D Gizmo Tools**

### 5.2 Aligning Objects in 3D Space
- Align Command
- 3D Align Command

**Practice 5b Aligning Objects in 3D**

### 5.3 3D Modify Commands
- 3D Move and 3D Rotate
3D Scale .......................................................................................... 5-14
Mirroring Objects in 3D .................................................................. 5-14
Arraying Objects in 3D ................................................................. 5-15

Practice 5c Working with 3D Modify Commands ......................... 5-17
Practice 5d Architectural Project - Gallery ................................. 5-19
Chapter Review Questions ............................................................ 5-21
Command Summary ..................................................................... 5-23

Chapter 6: Advanced Solid Editing ................................................. 6-1
6.1 Editing Components of Solids .................................................. 6-2
    Editing Faces ........................................................................... 6-5
    Editing Edges ........................................................................ 6-5
    Editing Vertices ..................................................................... 6-6
    Modification Options ............................................................. 6-6
Practice 6a Editing Components of Solids .................................. 6-7
6.2 Editing Faces of Solids ............................................................. 6-8
    Extruding Faces ..................................................................... 6-9
    Offsetting Faces and Edges ................................................... 6-10
    Moving Faces ........................................................................ 6-11
    Rotating Faces ...................................................................... 6-12
    Tapering Faces ..................................................................... 6-13
    Removing Faces ..................................................................... 6-14
    Copying Faces ........................................................................ 6-15
Practice 6b Editing Faces of Solids .............................................. 6-16
6.3 Fillets and Chamfers on Solids .................................................. 6-18
Practice 6c Fillets and Chamfers on Solids ................................. 6-21
Practice 6d Mechanical Project: Bracket ..................................... 6-24
Chapter Review Questions ............................................................ 6-25
Command Summary ..................................................................... 6-27

Chapter 7: Additional Editing Tools ................................................. 7-1
7.1 Creating a Shell ................................................................. 7-2
Practice 7a Creating a Shell ........................................................ 7-3
7.2 Imprinting Edges of Solids ..................................................... 7-5
Practice 7b Imprinting Edges on a Solid .................................... 7-7
7.3 Slicing a Solid along a Plane .................................................. 7-8
Practice 7c Slicing a Solid ........................................................... 7-10
7.4 Interference Checking ............................................................ 7-12
## Practice 7d Interference Checking ..................................................... 7-16

### 7.5 Converting Objects to Surfaces .................................................. 7-18
- Creating Planar Surfaces from 2D Objects .................................. 7-18
- Converting 2D Objects to Surfaces ......................................... 7-18
- Converting Solids to Surfaces .................................................. 7-20

### 7.6 Converting Objects to Solids ....................................................... 7-21
- Converting 2D Objects to Solids .............................................. 7-21
- Converting Surfaces to Solids ............................................... 7-22
- Converting Solids or Surfaces to Wireframe .......................... 7-23

## Practice 7e Converting Objects to Surfaces and Solids .................. 7-24

## Practice 7f Mechanical Project - Connector ...................................... 7-27

### Chapter Review Questions................................................................... 7-28

### Command Summary ............................................................................. 7-29

## Chapter 8: Refining the View................................................................. 8-1

### 8.1 Working with Sections ................................................................ 8-2
- Working With Sections ......................................................... 8-2
- Setting the Section Plane ...................................................... 8-3
- Working with Live Sections ................................................... 8-5
- Generating Sections from Section Planes ........................... 8-7

## Practice 8a Working with Sections....................................................... 8-9

### 8.2 Working with Cameras ................................................................. 8-11
- Adjusting a Camera ............................................................... 8-13
- Clipping Camera Views ......................................................... 8-14

## Practice 8b Working with Cameras .................................................... 8-16

### 8.3 Managing Views in 3D ................................................................. 8-18
- Modifying Views ................................................................. 8-22

## Practice 8c Managing Views in 3D................................................... 8-24

### 8.4 Animating with ShowMotion ...................................................... 8-27

### 8.5 Creating ShowMotion Shots ..................................................... 8-29

## Practice 8d Animating with ShowMotion........................................... 8-32

### 8.6 Creating Animations ................................................................. 8-34
- Using Walk and Fly ............................................................ 8-35
- Animating a Walkthrough ..................................................... 8-38
- Animation Motion Paths ...................................................... 8-40

## Practice 8e Walking and Flying Through Models ....................... 8-42

### Chapter Review Questions ................................................................. 8-44

### Command Summary ............................................................................. 8-46

© 2017, ASCENT - Center for Technical Knowledge®

Sample provided by ASCENT for review only.
All copying and reuse strictly forbidden.
## AutoCAD 2018: 3D Drawing & Modeling

### Chapter 9: Point Clouds

9.1 Point Clouds

- Attach Point Cloud
- Point Cloud Contextual Tab
- Object Snap
- Dynamic UCS

### Practice 9a Attach a Point Cloud

### Practice 9b Working with Sections

### Chapter Review Questions

### Command Summary

---

### Chapter 10: Visualization

10.1 Creating Visual Styles

- Visual Style Settings

### Practice 10a Creating Visual Styles

10.2 Working with Materials

- Using the Materials Browser
- Libraries
- Adding Materials
- Attaching Materials by Layer
- Material Editor
- Texture Editor

### Practice 10b Working with Materials

10.3 Specifying Light Sources

- Default Lighting
- Sunlight
- User-Defined Lights
- Modifying Lights

### Practice 10c Creating a Sun Study

### Practice 10d Placing Lights in a Model

10.4 Rendering Concepts

- Adjusting the Exposure
- Render Presets Manager

### Practice 10e Rendering Concepts

### Chapter Review Questions

### Command Summary

---
Chapter 11: Working Drawings from 3D Models ........................................ 11-1

11.1 Creating Multiple Viewports .......................................................... 11-2
Practice 11a Creating Multiple Viewports ........................................... 11-5

11.2 2D Views from 3D Solids ............................................................... 11-8
    Creating Hidden Line Views ......................................................... 11-9
    Creating Profiles from Solids .................................................... 11-11
Practice 11b 2D Views from 3D Solids .............................................. 11-13

11.3 Creating Technical Drawings with Flatshot .................................... 11-17
Practice 11c Creating Technical Drawings with Flatshot .................... 11-20
Practice 11d Mechanical Project - Saddle ......................................... 11-22

11.4 3D Model Import .......................................................................... 11-23

11.5 Automatic Model Documentation .................................................. 11-24
    Adding Base Views ..................................................................... 11-25
    Adding Projected Views ............................................................. 11-27
    Editing Drawing Views ............................................................... 11-30
Practice 11e Creating Automatic Model Documentation ..................... 11-32

11.6 3D Printing .................................................................................. 11-37
    Print Studio ................................................................................ 11-37
    3D Print Service .......................................................................... 11-40
Practice 11f Send a 3D Model to Print .............................................. 11-41

Chapter Review Questions ..................................................................... 11-43

Command Summary ............................................................................ 11-45

Appendix A: Skills Assessment ............................................................ A-1

Index .................................................................................................. Index-1
Preface

The AutoCAD® 2018: 3D Drawing and Modeling student guide introduces users who are proficient with the 2D commands in the AutoCAD® software to the concepts and methods of 3D modeling. The student guide provides a thorough grounding in the fundamentals of 3D and explores the main features of the advanced 3D Modeling workspace in the AutoCAD software.

Topics Covered:

• 3D viewing techniques
• Working with simple and composite solids
• Creating complex solids and surfaces
• Modifying objects in 3D space
• Editing solids
• Creating sections, camera perspectives, and animations
• Working with point clouds
• Converting 3D objects
• Setting up a rendering with materials and lights
• Creating 2D drawings from 3D models
• Working with the User Coordinate System
• Set up a drawing for 3D Prints

Note on Software Setup

This student guide assumes a standard installation of the software using the default preferences during installation. Lectures and practices use the standard software templates and default options for the Content Libraries.
Students and Educators can Access Free Autodesk Software and Resources

Autodesk challenges you to get started with free educational licenses for professional software and creativity apps used by millions of architects, engineers, designers, and hobbyists today. Bring Autodesk software into your classroom, studio, or workshop to learn, teach, and explore real-world design challenges the way professionals do.

Get started today - register at the Autodesk Education Community and download one of the many Autodesk software applications available.

Visit www.autodesk.com/joinedu/

*Note: Free products are subject to the terms and conditions of the end-user license and services agreement that accompanies the software. The software is for personal use for education purposes and is not intended for classroom or lab use.*

Lead Contributor: Michelle Rasmussen

Specializing in the civil engineering industry, Michelle authors student guides and provides instruction, support, and implementation on all Autodesk infrastructure solutions, in addition to general AutoCAD.

Michelle began her career in the Air Force working in the Civil Engineering unit as a surveyor, designer, and construction manager. She has also worked for municipalities and consulting engineering firms as an engineering/GIS technician. Michelle holds a Bachelor’s of Science degree from the University of Utah along with a Master’s of Business Administration from Kaplan University.

Michelle is an Autodesk Certified Instructor (ACI) as well as an Autodesk Certified Evaluator, teaching and evaluating other Autodesk Instructors for the ACI program. In addition, she holds the Autodesk Certified Professional certification for Civil 3D and is trained in Instructional Design.

As a skilled communicator, Michelle effectively leads classes, webcasts and consults with clients to achieve their business objectives.

Michelle Rasmussen has been the Lead Contributor for *AutoCAD 3D Drawing and Modeling* since 2015.
In this Guide

The following images highlight some of the features that can be found in this Student Guide.

### Practice Files

The Practice Files page tells you how to download and install the practice files that are provided with this student guide.

### FTP link for practice files

To download the practice files for this student guide, use the following steps:

1. Type the URL underlined below into the address bar of your Internet browser. The URL must be copied exactly as shown. If you are using an ASCENT ebook, you can still click on the link to download the file.

2. Press Enter to download the ZIP file that contains the Practice Files.

3. On the download complete screen, unzip the file to a local folder. The unzipped file contains an EES.exe.

4. Double-click on the EES.exe file to follow the instructions to automatically install the Practice File list on the C drive of your computer.

- *Note:* The file path in which the Practice Files folder is installed.

Doing so can help prevent errors when completing the practices in this student guide.

http://www.ASCENTed.com/getfile?id=xxxxxxxx

### Learning Objectives for the chapter

Each chapter begins with a brief introduction and a list of the chapter’s Learning Objectives.

### Chapters

- Practice Files
- FTP link for practice files
- Learning Objectives for the chapter
- Chapters
- Getting Started
Side notes

Side notes are hints or additional information for the current topic.

Instructional Content

Each chapter is split into a series of sections of instructional content on specific topics. These lectures include the descriptions, step-by-step procedures, figures, hints, and information you need to achieve the chapter’s Learning Objectives.

Practice Objectives

Practices

Practices enable you to use the software to perform a hands-on review of a topic.

Some practices require you to use prepared practice files, which can be downloaded from the link found on the Practice Files page.

Chapter Review Questions

Chapter review questions, located at the end of each chapter, enable you to review the key concepts and learning objectives of the chapter.
Command Summary

The Command Summary is located at the end of each chapter. It contains a list of the software commands that are used throughout the chapter, and provides information on where the command is found in the software.

Certification Exam Objectives

This appendix includes a list of the topics and objectives for the Autodesk Certification exams, and the chapter and section in which the relevant content can be found.

Icons in this Student Guide

The following icons are used to help you quickly and easily find helpful information.

- **New in 2018** Indicates items that are new in the AutoCAD 2018 software.
- **Enhanced in 2018** Indicates items that have been enhanced in the AutoCAD 2018 software.
Chapter 1

3D Foundations

In this chapter you learn how to identify 3D models, use the 3D workspace, view a 3D model from different angles, shade the model using visual styles, and understand the user coordinate system (UCS).

Learning Objectives in this Chapter

• Describe the differences between 2D drawings and 3D models.
• Access the 3D drawing and viewing tools using the ribbon through 3D-specific workspaces.
• View objects from all directions using preset 3D views and 3D orbiting tools.
• Control how elements display in a view using the visual styles.
• Navigate 3D drawings with additional tools, including the ViewCube and the SteeringWheel.
• Move the UCS to a face on a 3D object using the Dynamic UCS.
1.1 Why Use 3D?

2D plans and schematics are diagrams that represent an object by reducing it to a simpler form. For example, two parallel lines are easily recognized as the symbol for a wall, although they are not actually a wall. However, a 3D model is a complete object in all its dimensions. A complete 3D model of a wall can include all interior framing, the drywall, baseboards, etc. At the very least, it would display the height, length, and width of the wall.

Likewise, a three-view 2D mechanical drawing is a symbolic representation of an object from various directions. If you want to view the object from another angle, you must draw another 2D view. However, a 3D mechanical model is a single object that can be viewed from many directions as shown in Figure 1–1.

Figure 1–1

A 3D model:

• Can be viewed from any direction.
• Can be used to generate 2D views as required.
• Can be rendered to create photo-realistic images of the finished model.

Types of 3D Models

You can create four types of 3D models with the AutoCAD® software: wireframe, surface, mesh, and solid, as shown in Figure 1–2.
Wireframe models: Represent the 3D object by indicating its edges. There are no surfaces between the edges. Therefore, you can see through the object. For example, you can use a wireframe drawing to display a plumbing riser diagram. You can also use wireframe objects as paths or frameworks for other 3D objects.

Surface models: Consist of infinitely thin surfaces that represent the shell of an object. Since the surfaces are opaque, the edges behind them can be hidden. However, the model cannot be used for mechanical or thermal analysis because the thin surfaces do not have a mass. You can use surfaces to create contour maps or other complex geometry, such as a car body or cell phone design. You can also use surfaces to cut solids and apply complex geometry to them.

Mesh models: Consist of polygons that form edges, faces, and vertices. They do not have mass and can be used to create complex shapes that can be creased, split, and deformed as required. They can be shaded and rendered without having a mass and can be a useful alternative to solids.

Solid models: Can look like surface models, but are solid blocks of material, rather than hollow. A solid model has mass and can be used for mechanical and thermal analysis, and renderings. Solids can be used to create anything from a doorknob, to a large machine, or to a massing study for a new high-rise.

Hint: Advanced 3D modeling

The 3D tools in the AutoCAD software are primarily for conceptual design, but can be used to create objects and then to create working drawings from them. Autodesk supplies vertical software, such as Autodesk® Inventor® for mechanical design, Autodesk® Revit® Architecture for architectural design, and AutoCAD® Civil 3D® and Autodesk InfraWorks 360 for civil design, each of which are more powerful in their specific disciplines. For advanced rendering and animations, you would use the Autodesk® 3ds Max® software.
1.2 Introduction to the 3D Modeling Workspace

When you are ready to begin working in 3D, you need special tools and visual clues to help you move from the flat 2D world into the full-featured world of the third dimension. The AutoCAD software includes a 3D modeling workspace with easy access to 3D drawing and viewing tools, as shown in Figure 1–3.

- To open the 3D Modeling workspace, expand the Drafting & Annotation drop-down list in the Quick Access Toolbar and select **3D Modeling**.
- You can also use the 3D Basics workspace, which contains many commonly used commands.
- Use the ribbon tabs and panels to access the 3D tools.
- Toggle the Tool Palettes off or set them to **Auto-Hide** to save space in the drawing window. They are primarily used for lights and other visualization commands.

**3D Ribbon Panels**

The 3D Modeling workspace includes ribbon tabs and panels that contain commonly used 3D tools. The tabs are: **Home**, **Solid**, **Surface**, **Mesh**, **Visualize**, **Parametric**, **Insert**, **Annotate**, **View**, **Manage**, and **Output**.
The 3D Basics workspace contains the Home, Visualize, Insert, View, Manage, and Output tabs.

The Home tab includes the following panels: Modeling, Mesh, Solid Editing, Draw, Modify, Section, Coordinates, View, Selection, Layers, Groups, and View, as shown in Figure 1–4.

The Solid tab includes the following panels: Primitives, Solid, Boolean, Solid Editing, Section, and Selection, as shown in Figure 1–5.

The Surface tab includes the following panels: Create, Edit, Control Vertices, Curves, Project Geometry, and Analysis, as shown in Figure 1–6.
The *Mesh* tab includes the following panels: Primitives, Mesh, Mesh Edit, Convert Mesh, Section, and Selection, as shown in Figure 1–7.

![Figure 1–7](image)

The *Visualize* tab includes the following panels: Views, Coordinates, Model Viewports, Visual Styles, Lights, Sun & Location, Materials, Camera, Render, and A360, as shown in Figure 1–8.

![Figure 1–8](image)

The *View* tab includes the following panels: Viewport Tools, Palettes, and Interface, as shown in Figure 1–9.

![Figure 1–9](image)
1.3 Basic 3D Viewing Tools

As you are working in 3D, you need to be able to view objects from all directions. There are several basic tools that enable you to do so: preset 3D views, orbiting, and Visual Styles.

The AutoCAD software provides a number of standard preset 3D views (orthographic and isometric) that enable you to quickly change the viewing angle. They are located in the *Home* tab > *View* panel, as shown in Figure 1–10.

**Preset 3D Views**

Orthographic views display as if you are facing directly onto one side of a part. Isometric views typically display three sides, as if you are facing a corner. For example, an orthographic view of the cube would display one face: a square. An isometric view might display the top, left, and front sides of the cube.

- Orthographic views change the active drawing plane (UCS) of the view, while isometric views do not. To return to the flat drawing plane, select the *Top* view before continuing with a non-orthographic 3D view.

**Orbiting in 3D**

The best tools for viewing in 3D are the mouse and keyboard. You can zoom in and out using the mouse’s scroll wheel and can pan by holding the scroll wheel and dragging the mouse. Both methods are useful in 2D and 3D. However, in 3D you also need to view the model from all sides. Hold <Shift> and the scroll wheel of the mouse to temporarily orbit the objects in your drawing, as shown in Figure 1–11.
• When you orbit, the target (what you are viewing) stays stationary while the camera (your viewpoint) moves.

• You can also hold <Ctrl> and the scroll wheel to temporarily swivel. This is similar to panning the camera as you drag the mouse. The target of the view changes.

• If you select objects before you start orbiting, only those objects display as you move around the drawing. This is useful in complex drawings, because limiting the number of objects results in a smoother rotation of the view.

Additional Orbiting Commands

Additional orbiting commands are available in the View tab> Navigate panel and in the Navigation Bar, as shown in Figure 1–12.

**Figure 1–12**

<table>
<thead>
<tr>
<th>Orbit: Orbits along the XY plane or Z-axis.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free Orbit: Orbits without any constraint to a plane or axis. A green circle called an arc ball displays. When you move the cursor over different parts of the arc ball, the view moves in different directions.</td>
</tr>
<tr>
<td>Continuous Orbit: Rotates the viewpoint at a constant speed until you stop the rotation. Gives the impression of spinning the object in 3D space. To start the rotation, hold the mouse button, move the cursor, and release the button. The speed at which you move the cursor determines the speed of rotation, and the direction in which you move the cursor determines the direction of rotation.</td>
</tr>
</tbody>
</table>

• Use the mouse button rather than the scroll wheel to move around the drawing.

• When you are in a command, right-click to change between the various 3D viewing commands.
Using Visual Styles

While viewing a model, setting a visual style can help you gain a clearer understanding of the model. Visual styles control how elements display in a view. They might display all edges of the objects at the same time or just the ones closest to the viewer. Materials associated with the objects might be displayed or only shaded surfaces. You can add and modify objects and orbit in any of the visual styles.

Twelve visual styles come with the AutoCAD software: 2D Wireframe, 3D Hidden, 3dWireframe, Conceptual, Hidden, Realistic, Shaded, Shaded with Edges, Shades of Gray, Sketchy, Wireframe, and X-Ray. Select a Visual Style by expanding Realistic in the Home tab>View panel and then selecting an option, as shown in Figure 1–13.

![Visual Styles Selection](image)

**Figure 1–13**

- If you are working in an orthographic view, set the visual style to **2D Wireframe** for the best results.
- In Paper Space, you must be in an active Model Space viewport before applying a visual style.
1.4 3D Navigation Tools

The AutoCAD software includes two additional tools to help you navigate 3D drawings: the ViewCube and the SteeringWheel (located in the Navigation Bar), as shown in Figure 1–14.

![ViewCube](image1)

The ViewCube provides visual clues as to where you are in a 3D drawing and makes it easier to navigate to standard views, such as top, front, right, corner and directional views. Move the cursor over one of the highlighted options and select it. You can also click and drag on the ViewCube to rotate the box, which rotates the model. The ViewCube is shown in Figure 1–15.

![ViewCube](image2)

- (Home) displays when you move the cursor over the ViewCube. Click it to return to the view defined as Home.

- To toggle the ViewCube on and off, expand (User Interface) in the View tab>User Interface panel and select ViewCube.
Hint: Parallel and Perspective Views

Traditional 2D drawings display objects in orthographic (parallel) views, where parallel edges on the object seem to be parallel in the drawing. Perspective views display as the eye sees and parallel edges seem to converge at a vanishing point on the horizon. You can view the model in either Parallel or Perspective projection, as shown in Figure 1–16.

A parallel view helps you to evaluate the object’s shape and size proportions without any distortion, while a perspective view gives you a better sense of space and depth, especially with large objects (such as buildings).

- You can draw, select, and modify objects while you are in a perspective view.
- You can switch between Parallel, Perspective, and Perspective with Ortho Faces when you right-click on the ViewCube or while you are in a 3D Orbit command.
- Perspective mode is not available in the 2D wireframe visual style.
- If you save a drawing as a version earlier than the AutoCAD 2007 software, the Perspective view is automatically toggled off.
ViewCube Settings

ViewCube settings control the display of the ViewCube, how it works when you are dragging or clicking, and several other settings. Right-click on the ViewCube and select **ViewCube Settings**... to open the ViewCube Settings dialog box, as shown in Figure 1–17.

![ViewCube Settings dialog box](image)

**Figure 1–17**
SteeringWheel

The SteeringWheel provides access to navigation commands such as **Zoom**, **Pan**, **Orbit**, and **Rewind**. The **Rewind** command navigates through all previous views of the model.

**How To: Use the SteeringWheel**

1. In the Navigation Bar, expand (Full Navigation Wheel) and select a SteeringWheel.
   - Alternatively, you can expand (Steering Wheel) in the Navigation Bar or type `navswheel` in the command line.

2. In the SteeringWheel, hover the cursor over the navigation command that you want to use.
3. Click and hold the mouse button to start the navigation command.
4. Move the cursor to change the view as required.
5. Release the mouse button to end the navigation command.
6. Close the SteeringWheel.
   - The SteeringWheel follows the cursor in the drawing window. Verify that the cursor is positioned correctly before launching a navigation command.

**Full SteeringWheels**

You can select from three different full wheels: Full Navigation, View Object, and Tour Building. The Full Navigation wheel includes all of the navigation tools, the Basic View Object wheel contains **Center**, **Zoom**, **Rewind**, and **Orbit**, and the Basic Tour Building wheel contains **Forward**, **Look**, **Rewind**, and **Up/Down**. The full wheels are shown in Figure 1–18.

To close the SteeringWheel, press <Esc> or <Enter> or click the X in the SteeringWheel.

![SteeringWheel Options](image-url)
Mini Wheels

The mini wheels provide access to similar commands as the full wheels, but use a smaller icon with pie-shaped wedges. As the icon moves with the cursor (while you are in the **SteeringWheel** command), the mini wheels provide more screen space by eliminating the text descriptions on the wheel. The mini wheels and their commands are shown in Figure 1–19.

Right-click on the **SteeringWheel** to change between the different types of wheels.

Rewind Command

Use the **Rewind** command to navigate to previously displayed views of the model, as shown in Figure 1–20.

How To: Use the Rewind Command

1. Start the **SteeringWheel** command.
2. Hover the cursor over the **Rewind** option.
3. Click and hold the mouse button to start the **Rewind** command. A series of thumbnails display.
4. Move the cursor over the thumbnails to navigate to the highlighted view. The model updates as you move over the thumbnails.
5. Release the mouse button to make the highlighted view active.
SteeringWheel Settings

The SteeringWheels Settings dialog box controls the appearance of the SteeringWheels. With a SteeringWheel active, right-click and select **SteeringWheels Settings...** to open the dialog box, as shown in Figure 1–21.

![SteeringWheels Settings dialog box](image)

**Figure 1–21**
Practice 1a  3D Navigation Tools

Practice Objectives

- Navigate around a 3D model using preset views, manual orbiting tools, ViewCube, and the SteeringWheel.
- Modify the display and appearance of a 3D model by changing the visual style.

In this practice you will access preset views, orbit the drawing, and test visual styles. You will also use the ViewCube and SteeringWheel to view the drawing. You can use an architectural drawing (as shown in Figure 1–22) or a mechanical drawing (as shown in Figure 1–23).

Figure 1–22

Task 1 - Navigate the model.

1. In the Quick Access Toolbar>Workspace drop-down list, select 3D Modeling.

2. Open 3D-Solid-Nav.dwg (mechanical) or Museum-Concept.dwg (architectural).

3. In the Home tab>View panel, use the view presets to display several views of the part or building (Left, Right, SE Isometric, etc.). Finish by selecting the Top view to reset the UCS and then select an isometric view.
4. Hold <Shift> + the middle mouse wheel to use 3DOrbit and move around the part or building, displaying the different sides.

5. In the Home tab>View panel, change the different visual styles to display different appearances for the part or building (Realistic, Conceptual, etc.).

**Task 2 - Work with the ViewCube**

1. Use the ViewCube and navigate to different views using the various sides and corners of the cube.

2. Click  (Home) to return to the Home view.

3. Hold <Shift> + the middle mouse button and orbit to a different view. The ViewCube follows the direction of the cursor.

4. Right-click on the ViewCube and select **Set Current View as Home**.

5. Use the ViewCube to change the view and click  (Home) again. It returns to the view you specified as Home.

**Task 3 - Use the SteeringWheel.**

1. In the Navigation Bar, expand  (Full Navigation Wheel) and select **Mini Full Navigation Wheel**.

2. Zoom, orbit, and pan using the SteeringWheel tools, as shown with the mechanical part in Figure 1–23.

---

**Figure 1–23**
3. Rewind back to your first view.

4. Right-click on the SteeringWheel, expand Basic Wheels, and select **View Object Wheel**.

5. Try the viewing tools in this SteeringWheel.

6. Right-click again and select **Mini View Object Wheel**. Change the view using this SteeringWheel.

7. Change to one of the other mini wheels and try any tools you have not yet used, such as **Walk** or **Look**.

8. When you have finished trying the new tools, right-click and select **Go Home**. The view returns to the last specified home.

9. Right-click and select **Close Wheel**.

10. Save the drawing.
1.5 Introduction to the User Coordinate System (UCS)

In the AutoCAD software, 2D objects are created on a single flat plane, which is usually the XY plane. In 3D, you can work on the XY plane or change to another plane, as shown in Figure 1–24.

![Figure 1–24](image)

There are three axes: the X-axis, Y-axis, and Z-axis. Three planes are also automatically created by the intersections of these axes. They are the XY plane, the YZ plane, and the XZ plane. Together these three axes and their planes make up a user coordinate system, or UCS. The UCS is a user-defined working plane with X,Y coordinates that can be positioned at any location or orientation in space.

When you draw on the UCS, you can use the same commands and methods regardless of the angle or location to which the XY plane has changed. Drawing in 3D is very similar to drawing in 2D. The only difference is that you add information for the Z-direction as well for the thickness, elevation, or height. Many 2D commands can be used to start or add to 3D drawings.

- Do not confuse the UCS position with the viewing direction. The position from which you view your drawing, known as the viewpoint, determines how you see your drawing. The UCS determines where you are drawing. It sets the position of the working plane.

- Each viewport can have its own UCS.
Modeling with Dynamic Feedback

Most of the 3D commands display dynamic feedback as you draw. Not only can you select points to define the dimensions of the object, including its height, but this information also displays in the drawing window as you work. You can type specific numbers or select points with the cursor, as shown in Figure 1–25.

![Figure 1–25](image1.png)

- POLAR, OTRACK, and ORTHO work with dynamic input in the Z-axis direction.

Dynamic UCS

Rather than frequently changing the UCS, you can use the Dynamic UCS (DUCS) command to temporarily move the UCS to a face on a 3D object while you are drawing, as shown in Figure 1–26. While you are in a command, move the cursor over the edge of a face until it is highlighted, and then proceed with the command. The UCS icon moves to that face and the next objects created align with the coordinate system of the face. When the command is finished, the UCS returns to its previous location.

![Figure 1–26](image2.png)
• The Dynamic UCS can be toggled on and off by clicking (Allow/Disallow Dynamic UCS) in the Status Bar, as shown in Figure 1–27.

Figure 1–27

• Object snaps can interfere with the selection when you are identifying the face you want to use. Toggle off (Object Snap) in the Status Bar or press <F3> until you have selected the face you want to use. You can also use the None Object Snap Override to temporarily toggle off Object Snap.

• You can use 3D object snaps by toggling on (3D Object Snap) in the Status Bar. They include: Vertex, Midpoint on Edge, Center of face, Knot, Perpendicular, and Nearest to face and are useful when snapping to points on 3D objects.

• To change the current UCS to a different face in the drawing, start the UCS command, select the face, and press <Enter>. The UCS moves to the selected face. If the grid is on, it aligns with the new UCS as well.

• The World Coordinate System is the drawing's original and master coordinate setup. Type UCS and select World to restore the drawing coordinates to the master coordinate system.
**Practice 1b**

**Estimated time for completion: 5 minutes**

---

**Introduction to the User Coordinate System**

**Practice Objective**

- Add 2D objects to various faces on a 3D model using Dynamic UCS.

In this practice you will add 2D objects to a simple solid model using Dynamic UCS, and view the model with 3D Navigation commands.

1. Open **DUCS.dwg**.

2. In the Status Bar, toggle on (Grid Display), (Dynamic UCS), (Dynamic Input), and (Lineweight), if they are not already on.

3. In the Status Bar, toggle off (Object Snap) and (3D Object Snap).

4. Orbit the model to display the faces labeled A, B, C, D, and E. Finish with a view in which Face A displays.

5. In the **Home** tab>**Draw** panel, click (Line). Hover over Face A until it highlights and add several lines to the surface, similar to those shown in Figure 1–28.

---

**Figure 1–28**
6. Click (Circle). Hover over Face B until it highlights. Draw a small circle anywhere on Face B.

7. Draw another circle on Face C.

8. Orbit the model to display Faces D and E. Draw objects on those faces.

9. Finish with the **SE Isometric** view and save the drawing.
Chapter Review Questions

1. Which of the following is a type of 3D model?
   a. Cone
   b. Mesh
   c. Box
   d. Cylinder

2. The Visualize tab contains tools that enable you to add lights and materials to the model.
   a. True
   b. False

3. Which of the following is a preset 3D view?
   a. SW Isometric
   b. Top
   c. Front
   d. All of the above.

4. When using the ViewCube to view a model in 3D, which of the following icons near the ViewCube can you click to return to the original view?
   a. Top
   b. WCS
   c. W
   d. Home

5. Which of the following is true of the Dynamic UCS?
   a. When you move the UCS to a selected face on a 3D object, it remains there until it is moved again.
   b. It cannot be used with object snaps.
   c. It cannot be toggled on or off.
   d. Temporarily moves the UCS to a selected face on a 3D object.

6. You cannot use 2D commands to start or modify 3D drawings.
   a. True
   b. False
## Command Summary

All ribbon names reference the 3D Modeling workspace.

<table>
<thead>
<tr>
<th>Button</th>
<th>Command</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Allow/Disallow Dynamic UCS" /></td>
<td>Allow/Disallow Dynamic UCS</td>
<td>• Status Bar</td>
</tr>
</tbody>
</table>
| ![Continuous Orbit](image) | Continuous Orbit | • Ribbon: View tab>Navigate panel  
• Navigation Bar |
| ![Free Orbit](image) | Free Orbit | • Ribbon: View tab>Navigate panel  
• Navigation Bar |
| ![Home](image) | Home | • ViewCube |
| ![Orbit](image) | Orbit | • Ribbon: View tab>Navigate panel  
• Navigation Bar |
| ![Preset Views](image) | Preset Views | • Ribbon: Home tab>View panel |
| ![SteeringWheel](image) | SteeringWheel | • Ribbon: View tab>Navigate panel  
• Navigation Bar |
| ![User Interface](image) | User Interface | • Ribbon: View tab>User Interface panel |
| ![ViewCube Display](image) | ViewCube Display | • Ribbon: View tab>User Interface panel>User Interface drop-down list |
| ![Visual Styles](image) | Visual Styles | • Ribbon: Home tab>View panel  
or View tab>Visual Styles panel |
| ![Drafting & Annotation](image) | Workspace Switching | • Quick Access Toolbar  
• Status Bar |